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Safety Information 
The Agilent Gly-Q system (formerly ProZyme) is intended to be installed and operated by the end 
user. To operate the system safely please review the following information.

 

WARNING
Both the instrument and the gel recharging air pump must be connected to an appropriate 
power source. (See “System Specifications” on page 48.)

WARNING
Do not operate the system if any of the power cords are damaged.

WARNING
The Gly-Q system is based on capillary gel electrophoresis separation driven by high voltage. 
Do not remove covers. Do not perform any maintenance of the electrical components.

CAUTION The instrument autosampler rotates and moves during operation. Keep the instrument door 
closed while running to avoid potential pinching hazard. Do not put your hands into the 
autosampler chamber unless the instrument is put into either the “Load Reagents” position or 
the “Load Samples” position and the autosampler has stopped moving.

CAUTION Follow local biohazard material handling regulations when working with human or animal 
samples.

Suggestion: Wear appropriate gloves when handling samples and reagents used with the 
system.

CAUTION Always turn off the power to the gel recharging air pump when emptying the condensation 
trap.





6 Agilent Gly-Q Glycan Analysis System User Manual

Introduction 

The Agilent Gly-Q system (formerly ProZyme)
The Gly-Q System is designed as a complete system for rapid analysis of oligosaccharides such 
as glycans. The system is comprised of capillary gel electrophoresis core integrated with a high 
sensitivity fluorescence detector and 96-well autosampler, replaceable capillary gel cartridge, gel 
recharging pump, Gly-Q Manager software and Gly-X with InstantQ assay kits and standards.    

Description of system components
The Gly-Q System components are listed in Table 1 and described in more details in the sections 
that follow.

Table 1 Agilent Gly-Q System components 


Agilent Gly-Q Instrument 
Product code GQ2000


Agilent Gel recharging air pump (formerly ProZyme) 
Product code GQ2000-A


Replaceable capillary gel cartridge


Assay kit


Standards and Controls
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
Agilent Gly-Q manager software (formerly 
ProZyme)


Cartridge priming station


Agilent Gly-X manifold spacer (formerly ProZyme)

Table 1 Agilent Gly-Q System components (continued)
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Gly-Q instrument

The Gly-Q Instrument is a compact unit comprised of a capillary gel electrophoresis core 
integrated with a high sensitivity fluorescence detector and 96-well autosampler. When used as 
part of a complete system, the instrument facilitates rapid separation, identification and relative 
quantitation of labeled oligosaccharides. See “System Specifications” on page 48 for instrument 
specifications.

Figure 1. Agilent Gly-Q instrument

Feature Description

Instrument status LED LED light serves as an indicator of the instrument status. The light blinks when high voltage is 
applied to the capillary.

96-well plate 
autosampler

The autosampler holds a 96-well microplate, system reagent vials and reagent trays. The 
autosampler moves and rotates during operation. The autosampler interior is protected by a 
hinged plastic door. 

Power button The power button turns the instrument On and Off

Air pressure gauge Air pressure gauge displays inlet air pressure

Air inlet port 1/8 inch tube connector used for connecting instrument to gel recharging air pump

USB port Computer port

Power inlet Power supply port

Cartridge compartment door

Instrument status LED

96-well plate autosampler

Power button

Air pressure gauge

Air inlet port
USB port

Power inlet

Instrument label
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Gel recharging air pump

The gel recharging air pump connects to the instrument and provides air pressure for automated 
recharging of the capillary with gel between sample injections. See “System Specifications” on 
page 48 for pump specifications.

Cartridge priming station 

The cartridge priming station is designed to prepare the cartridge for first-time use before 
installing it into Gly-Q Instrument. The priming station can also be used to help troubleshoot 
cartridge clogging.

Figure 2. Agilent Gel recharging air pump

Feature Description

Air tubing (not shown) 1/8 inch tubing connects the pump to the instrument.

Power switch Power switch turns the pump On and Off. 

Condensation trap Condensation trap collects condensate from air pump. This should be emptied weekly as routine 
maintenance.

Air outlet port 1/8 inch tube connector used for connecting gel recharging air pump to Instrument.

Power inlet (not 
shown on the back of 
the unit)

Power supply port.

Figure 3. Cartridge priming station

Condensation trap

Air outlet port

Power switch
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Replaceable capillary gel cartridge

The replaceable capillary gel cartridge contains a 147-mm capillary mounted into the cartridge 
body with a gel matrix top reservoir and built-in electrode pins. The capillary is automatically 
refilled with gel matrix between sample runs.

Figure 4. Replaceable capillary gel cartridge

Feature Description

Capillary Glass capillary. 
Note: fragile glass tip extends beyond metal cartridge tip 

Anode pin A pin that connects to a positively charged electrode

Cathode pin A pin that connects to a negatively charged electrode

Label Cartridge label with lot number and expiration date

Gel reservoir Top reservoir containing separation gel

Guiding groove Molded groove ensures correct cartridge positioning within the instrument

Cartridge tip Metal tip of the cartridge

Label

Anode pin

Capillary

Cathode pin

Gel reservoir

Guiding grove

Cartridge tip

Glass capillary tip
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Sample preparation and Analysis kits

Agilent Gly-X N-Glycan rapid release and Labeling kits (formerly ProZyme)

Gly-X sample preparation kits use a novel in-solution enzymatic deglycosylation followed by 
labeling of released N-glycans with proprietary Agilent Instant dyes (formerly ProZyme). Gly-X with 
InstantPC (GX96-IPC) is designed for UHPLC and LC-MS applications. Gly-X with InstantQ 
(GX96-IPC) is specifically designed for CE separation on the Gly-Q System. Labeling (one minute) 
with InstantQ dye is followed by a simple 96-well vacuum plate-based clean up step. The samples 
are then ready for analysis on the Gly-Q Instrument. With the deglycosylation and labeling all 
carried out in solution, the method is simple, rapid, and suitable for automation. 

Figure 5. Assay kit

Feature Description

Gly-X Deglycosylation 
module for
InstantQ Dye 
GX96-300

Reagents and consumables for rapid in-solution protein deglycosylation:
• Gly-X Deglycosylation plate 
• Gly-X N-Glycanase 
• Gly-X Digestion buffer
• Gly-X Denaturant
• Gly-X Blocker (optional)

Gly-X InstantQ
Labeling module 
GX96-301 

Dye and solvents for instant labeling of released glycans: 
• InstantQ dye 
• InstantQ dye solvent 
• InstantQ activation reagent

Gly-X InstantQ 
Cleanup module 
GX96-302

Clean up plate, eluent and plastic consumables for sample clean-up before analysis:
• InstantQ cleanup plate A, 96 wells 
• Gly-X collection plate, 96 wells 
• Waste tray for vacuum manifold 
• Gly-X Used-well sealing caps, black (for cleanup plate)

Gly-Q 
Cartridge module 
GQ103

Gly-Q Cartridge, separation buffer, mineral oil and reagent tray: 
• Gly-Q Cartridge 
• Gly-Q Separation buffer
• Gly-Q Mineral oil 
• Gly-Q Reagent tray

Gly-Q Alignment 
standards module 
GKSQ-505

• Gly-Q Migration standards (GKSQ-500) 
• Gly-Q GU ladder (GKSQ-503)

Cartridge module

Deglycosylation module

Labeling module

Clean-up module

NOTE See the Agilent Gly-X Rapid N-Glycan Release and Labeling with InstantQ Kit User Manual 
(GX96-IQ) (formerly ProZyme) for more detailed product and protocol information.

NOTE Agilent GX100 Gly-X Manifold Spacer (formerly ProZyme) is required for the Agilent Gly-X 
Rapid Release and Labeling with InstantQ Dye Kit (formerly ProZyme). 
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Glycan standards

Gly-Q alignment standards 

Gly-Q glucose unit (GU) Ladder is generally the first run at the beginning of each sample sequence 
and produces >15 peaks in the electropherogram (see Figure 6). The Migration Standards (MS) 
coinjected with subsequent unknown samples will be aligned to the Maltodextrin (GU) ladder for 
glycan naming and alignment purposes. 

Gly-Q Migration Standards (MS) are co-injected along with each unknown sample. A lower 
migration standard (LMS) and upper migration standard (UMS) corresponding to 3 and 15 
glucose units respectively is used to align with the above described Maltodextrin (GU) ladder. 

InstantQ Glycan standards 

Standards are highly purified and well characterized individual oligosaccharides or mixed libraries 
of oligosaccharides. They are used for Gly-Q method calibration and validation. For the list of 
available InstantQ Standards and Controls, please refer to the following website links: 

InstantQ Labeled Oligosaccharides

https://www.agilent.com/en/product/biopharma-hplc-analysis/glycan-analysis/glycobiology-s
tandards-libraries/instantq-labeled-glycans

Figure 6. Electropherogram

Figure 7. Gly-Q Migration standards

LMS UMS

https://www.agilent.com/en/product/biopharma-hplc-analysis/glycan-analysis/glycobiology-standards-libraries/instantq-labeled-glycans
https://www.agilent.com/en/product/biopharma-hplc-analysis/glycan-analysis/glycobiology-standards-libraries/instantq-labeled-glycans
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Gly-Q manager software

The Gly-Q Manager software controls Gly-Q instrument, collects and processes data, and reports 
results. The software features are organized into tabs and ribbon groups for easy intuitive 
navigation.

Figure 8. Gly-Q Manager software

Instrument status bar

File

Sequence

Data
Processing method

Instrument method

Feature Description

File tab File tab enables and informs the user: 
• Serial number of Instrument and Cartridge 
• Gly-Q Manager software version 
• Air flow check 
• Gel flow check 

Sequence tab Sequence tab enables: 
• Access to the autosampler 
• Programming a sequence 
• Starting and Stopping a sequence 
• Monitoring sequence operations in real-time 

Data tab Data tab enables: 
• Data review 
• Integration adjustment 
• Data reprocessing 
• Data export/reporting

Processing method 
tab

Processing method tab enables: 
• Processing method design
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Instrument method 
tab

Instrument method tab enables: 
• Instrument method design 
• Saving an instrument method

Instrument status bar Instrument status bar informs the user: 
• Instrument connectivity 
• Progress of run 
• Estimated finish time of run

Feature Description

NOTE See “GLY-Q Manager Software” on page 22 for more detailed description of Gly-Q Manager 
functionality. 
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Installation

Unpacking 
Inspect shipping boxes. If you notice apparent damage, contact Agilent Technical Support at 
https://www.agilent.com/en/contact-us/page.

Unpack the system components and place them on the laboratory bench.

System location 
A suitable environment is important to ensure the best performance of the Gly-Q System. The 
recommended placement conditions are listed below: 

• Flat and stable laboratory bench with no devices generating vibrations

• Clear space above the instrument to allow for capillary gel cartridge insertion

• Clear space behind the instrument to allow for air circulation, electrical and air tubing 
connections

• The ambient temperature should be stable and within a range of 20 to 30 °C

• The optimal operating humidity should be within 40 to 95% RH range, noncondensing

• The optimum altitude for Gly-Q System operation is 20 to 2,000 m

Power requirements 
The input voltage of Gly-Q Instrument is 24 V DC and the maximum current is 1.25 A. A suitable 
power supply with a power cord is included in the package (100 to 240 V AC, 47 to 63 Hz). See 
“System Specifications” on page 48.

The input voltage of Gly-Q System gel recharging air pump is 12 V DC and the maximum current is 
6.67 A. A suitable power supply with a power cord is included in the package (100 to 240 V AC, 
47 to 63 Hz). See “System Specifications” on page 48.

Computer requirements

NOTE The Gly-Q Instrument contains sensitive optics that can be influenced by condensation. If the 
instrument was shipped in cold weather, do not remove the instrument from the shipping box 
immediately, allow it to warm up to room temperature.

• Operating System Windows 7, 8.1 or 10; 64-bit version

• Processor 1 GHz or faster CPU

• Memory Minimum 8 GB RAM

• Disk Drive 1 TB Hard Disk Drive or 500 GB Solid-State Drive preferred

• Disk Space Minimum 100 GB free space on drive (Solid-State Drive recommended)

• Monitor Minimum resolution 1920 x 1080 (Full HD)

• Graphics Card Supports Full HD (1920 x 1080 resolution)

• Port USB 2.0 or greater

https://www.agilent.com/en/contact-us/page
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System setup

1 Plug the air pump power supply, Gly-Q Instrument power supply, computer and monitor into 
approved and properly grounded power outlets. A surge protector is suggested to minimize 
power fluctuations. 

2 Plug each power supply low voltage line into the power inlet of the appropriate unit (Gly-Q 
Instrument power inlet and air pump power inlet). The two connectors are different to prevent 
using the wrong power supply.

3 Connect computer and Gly-Q Instrument with USB cable.

4 Connect air pump outlet and Gly-Q Instrument air inlet port with provided 1/8-inch tubing. The 
airline from the air pump to the instrument is bisected by an air filter. 

Software installation 

Figure 9. System setup

NOTE After turning on the air pump, it should run intermittently for less than one minute. If the air 
pump is running more consistently this is a sign of air pressure compromise that may affect 
performance. The user should check the air filter and tubing for possible leaks. Spare tubing 
and replacement air filter are shipped with the instrument. Contact Agilent if you need 
assistance.

Figure 10. Agilent Gly-Q Manager setup window





Agilent Gly-Q Glycan Analysis System User Manual 17

1 Log into PC as Administrator. 

2 Download the latest version of Gly-Q Manager from the Agilent website: 
https://www.agilent.com/en/products/capillary-electrophoresis-ce-ms/glycan-analyzer/gl
y-q.

3 Double click on the .exe file, click on Gly-Q Manager setup. 

4 Go through software installation steps. 

Cartridge preparation
Components

NOTE Please contact Agilent for password information.

NOTE If you have an older version of Gly-Q Manager software installed on your computer, you will be 
asked to uninstall it prior to installing a newer version. Installing new version of Gly-Q Manager 
will not delete data. All user data will be preserved during installation. 

Figure 11. Components

Red tape on cap

Capillary gel cartridge clam-shell container

Pin

Gel reservoir (Store the tip of the cartridge 
in the gel reservoir inside the clam-shell 
container.)

https://www.agilent.com/en/products/capillary-electrophoresis-ce-ms/glycan-analyzer/gly-q
https://www.agilent.com/en/products/capillary-electrophoresis-ce-ms/glycan-analyzer/gly-q
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Unpacking and Preparing the cartridge

1 Open gel-cartridge clam-shell container and remove the cartridge.

2 Peel off the tape from side and top of cartridge (retain top tape for storage of cartridge 
between uses).

3 Carefully remove and pin from package. Insert pin into the hole of the cartridge cap, and push 
it down to the end. Slight resistance should be encountered when performing this step.
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Priming the cartridge

This procedure is to prime new cartridges. For subsequent runs, we recommend running a Gel 
Flow Check (“File settings” on page 44) each day before the cartridge is used.

1 Turn off the Air Pump, and use the illustration in Figure 12 to reconnect the air tubing.

2 Put a buffer tray at the bottom of purge station. 

3 Slide the cartridge into the Cartridge Hanger and secure by turning the Locking Knob as 
illustrated in Figure 12. 

4 Push the knob on top of the regulator down.

5 Turn Air Pump ON.

6 Pull Regulator Knob UP and turn CLOCKWISE to open airflow until pressure reaches 
~ 0.4 mPa.

7 Droplets of gel should be observed flowing at cartridge tip in ~ 30 to 120 seconds.

8 Turn the Regulator Knob COUNTERCLOCKWISE until the airflow is OFF.

9 Once the pressure returns to 0, push the Regulator Knob DOWN.

10 Slowly release the cartridge and remove from priming station.

Figure 12. Priming station
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Inserting the cartridge into the instrument

1 Gently wipe the cartridge tip with Kimwipe or similar tissue. 

2 After gently depressing cartridge door atop Gly-Q Instrument, insert cartridge and close door. 
Push the cartridge to the bottom. 

3 Close the Cartridge door.

NOTE The glass capillary extends beyond the end of the metal tip, and is fragile, handle with care, do 
not tap tip on bench or hard surfaces.

Figure 13. Cartridge inserted in Gly-Q Instrument

NOTE Cartridges can only be inserted in one orientation as shown in Figure 13. 

NOTE Dispose of spent cartridges by using a needle clipper, available with most sharps hazard 
systems to remove cartridge tip. The remaining cartridge is safely disposed of as trash. The 
clam-shell package can be added to most plastics recycling streams.
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Ending a run
1 After samples have been processed, the system will return the Cartridge to the Park position 

(see “Autosampler layout” on page 25).

2 Use the “Load Sample” and “Load Reagents” buttons to remove sample plate and reagent tray.

3 Store the cartridge.

a Remove the cartridge from the instrument, and place tape over the cartridge cap (to cover 
the pin hole). Return it to the original clamshell packaging. The cartridge tip must be in 
contact with the gel block inside the package. Place inside the foil pouch, and store 
vertically at room temperature.

b To store on the instrument: Press the Park button before shutting down the system. The 
cartridge can remain on the system for up to three days. Ensure that the Park position in 
the buffer tray (see “Autosampler layout” on page 25) is filled with water to prevent the 
capillary tip from drying.

Vacuum manifold setup
Agilent recommends the use of Millipore MultiScreen Vacuum Manifold (96-well) and Millipore 
High Output Pump (WP6211560 for 115 V/60 Hz or WP6222050 for 220 V/50 Hz). 

1 Assemble the vacuum manifold.

2 Connect the vacuum manifold and pump inlet with tubing from the liquid trap reservoir.

3 Plug pump into an approved and properly grounded power outlet.

Figure 14. Vacuum manifold setup

Vacuum manifold

Tubing

Liquid trap reservoir

Pump inlet

NOTE For more detailed product information please refer to Millipore website: 

http://www.emdmillipore.com/US/en/product/MultiScreen%E2%84%A2-Vacuum-Manifold-9
6-well,MM_NF-MAVM0960R#overview

https://www.emdmillipore.com/US/en/product/High-Output-Pump,-115-V60-Hz,MM_NF-WP
6211560

http://www.emdmillipore.com/US/en/product/MultiScreen%E2%84%A2-Vacuum-Manifold-96-well,MM_NF-MAVM0960R#overview
https://www.emdmillipore.com/US/en/product/High-Output-Pump,-115-V60-Hz,MM_NF-WP6211560
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GLY-Q Manager Software

Starting Gly-Q manager
To start the Gly-Q Manager, double-click the Gly-Q Manager icon on the desktop or select Start -> 
Gly-Q Manager. 

Controlling and Monitoring Gly-Q instrument
To control and monitor the Gly-Q Instrument with Gly-Q Manager, the instrument must be turned 
on and connected to a computer with a USB cable. 

The samples are always analyzed as part of a sequence using a predefined set of instrument 
commands stored in an Instrument Method and a predefined set of processing commands 
stored in a Processing Method. 

When an analysis is running, you can monitor instrument operation through a status bar located 
at the bottom of the Gly-Q Manager screen, and observe real time detector signal and sequence 
progress on the autosampler layout and sequence progress table. 

Direct instrument controls are accessible from the Sequence tab, see Figure 15.

Park Cartridge - Moves cartridge into Park position for short term storage on the instrument (up 
to three days). 

Load Samples - Control rotates the autosampler for access to the sample loading stage. 

Load Reagents - Control rotates the autosampler for access to load reagents including GU Ladder 
and Migration Standards. 

Figure 15. Sequence tab
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Creating a sequence
A sequence defines how a group of samples is analyzed. Sequence can be created on the 
Sequence tab by defining the following fields: 

Project and Run 

1 Name your project by selecting New Project from the pull down, or select from the list of 
existing projects.

2 Name your run.

Instrument and Processing methods 

1 Select Instrument Method.

2 Select Processing Method.

Sample set 

1 Define the position of the first sample.

2 Define the direction the samples will be injected (↔ or ↕).

3 Define the number of samples to be analyzed.

4 Define the number of injections (number of replicates for each sample).

Figure 16. Project and Run options

Figure 17. Instrument and Procession method options

NOTE Default Instrument Methods are recommended. See “Creating a processing method” on 
page 37 and “Creating an instrument method” on page 42 on how to create Instrument 
Methods and Processing Methods. 

Figure 18. Sample set options
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Import and Export 

• Export feature allows for exporting a sequence in CSV (.xls) format

• Import feature allows for importing a sequence in CSV (.xls) format

Sequence preview

After a sequence is created, a table with a list of samples queued for analysis will be displayed on 
the main screen. 

NOTE It is possible to return to a well periodically within a Sequence for repeat injections by 
specifying the well in the Position Name dropdown (see Figure 19). Be sure to edit the Sample 
Name if appropriate.

Figure 19. Position name dropdown

NOTE Changes are saved automatically, and users are advised to double check these settings 
before starting a run. If needed, type sample names and comments into the sequence preview 
table or import sample set list from Excel, see import CSV in Figure 20.

Figure 20. Import and Export CSV options

Figure 21. Samples table





Agilent Gly-Q Glycan Analysis System User Manual 25

Autosampler layout

The autosampler layout will show color coded positions for samples, reagents and standards. 

Figure 22. Autosampler layout

Reagent tray for:

(P)Park; 4 mL DI water + mineral oil to cover, 
optional

(W)Wash/Waste; 4 mL DI water

(C)Clean; 4 mL DI water

(S)Separation Buffer; 4 mL, included with 
Gly-Q Cartridge module

P W

S C
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Sequence Status Bar 

An instrument status bar at the bottom of the screen will display the instrument status.

Running a sequence
Starting and Stopping a sequence

After a sequence is created it can be run by clicking Start.

Figure 23. Autosampler layout

A  Sample name

B  Instrument method step

C  Well position

D  Sequence progress and estimated time of completion

E  Cartridge injection counter

F  System Pressure

G  Instrument status

A B C D E F G

Figure 24. Start button

NOTE If the system cannot read the information on the cartridge RFID tag the dialog shown in 
Figure 25 opens allowing the information to be entered manually. The information is on the 
cartridge and on the pouch used to store the cartridges between use. To activate the 'Run' 
button enter the cartridge serial number and use the 'date picker' control shown circled in blue 
to enter the expiration date.

Figure 25. Cartridge information
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If a warning or error message regarding injection limits appears when starting a run refer to 
“FAQs” on page 53.

A sequence can be stopped by clicking Stop. 

Monitoring sequence progress

Sequence progress will be displayed on four elements of the screen.

Data review, export, reporting, and management
After data for all samples in a sequence have been acquired and processed, it is useful to review 
electropherograms and peak tables before reporting the results. Peak integration may need to be 
adjusted before results are reported. This work is done on the Data tab shown Figure 28.

NOTE Make certain there is a cartridge installed in the instrument.  If there is no cartridge in the 
instrument, then the system assumes the RFID tag is damaged and presents this dialog.

Figure 26. Stop button

Figure 27. Four sequence screen elements

A

B

C

D

A.  Sequence progress bar at the bottom of the screen will show time remaining for sequence completion.

B.  The electropherogram chart will show real time detector signal.

C.  The autosampler layout will show completed samples (green), failed samples (red), currently running 
sample (blue) and queued samples (grey).

D.  The sequence progress table will be updated with currently running sample highlighted in darker gray.
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1 Select the Data tab.
Data

2 On the Data Files tree, select the sample set.

Figure 28. Data tab

Figure 29. Data files

The Data tab includes the following four areas:

A  Data View Ribbon - this includes tools to adjust and to export data

B  Data Files tree - the data you wish to work on is selected here

C  Electropherogram - this is the data display which can include one or more samples

D  Samples table - this is a list of the data that has been selected using the Data Files tree. This table is used 
to select the samples that will be displayed on the Electropherogram and to review the peak table for the 
selected samples.

B

A

D

C
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3 On the Data View ribbon, select processed or raw data view and decide to show or hide 
annotations and instrument current signal.

4 On the Sample table, select the sample(s) you want to view.

5 Open the peak table for any or all of the samples selected by clicking on  sign before the 
sample name.

6 Review peak detection and integration by highlighting peak line in the peak table and reviewing 
peak start and end markers on electropherogram view. If needed, zoom in with a left mouse 
click/hold; zoom out with a right mouse click and selecting un-zoom.

Figure 30. Data view

NOTE Always start with processed data view with or without annotations. Raw data view and current 
are designed to aid in troubleshooting.

Figure 31. Sample table

Figure 32.

NOTE The Samples table will show Processed Peaks (within the processed data range, see 
“Integration parameters” on page 40) when viewing Processed Data, and will show Raw Peaks 
(all peaks) when viewing Raw Data.
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7 To make sure all peaks of interest are detected, adjust minimum peak area.

8 Reprocessing data. In some cases, one or more samples within a data set need to be 
reprocessed. To do this select the sample(s) to be reprocessed on the Samples table (NOT the 
Data Files tree). Multiple samples can be selected in the Samples table and all selected 
samples will be displayed in an overlay electropherogram plot as shown in Figure 35. This 
facilitates sample comparison, and allows reprocessing to be performed simultaneously on 
more than one sample. Use “Shift+Click” and/or “Control+Click” to select multiple samples as 
shown below.

Figure 33. Electropherogram

NOTE In rare circumstances, the Lower Migration Standards (LMS) or Upper Migration Standards 
(UMS) may require manual adjustment. It is important to view Raw Data when adjusting the 
LMS and/or the UMS. Please see “FAQs” on page 53 for further information.

Figure 34. Minimum Percent Area Adjustment

NOTE Default is set to 0.5%. This slider is only active when a single sample is selected in the 
Samples table. You cannot adjust the minimum percent area on more than one sample at a 
time.
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In some cases, data from different data sets must be reprocessed in an identical manner. Select 
data from multiple data sets in the Data Files tree and it will all be displayed in the Samples table. 
To reprocess them all together, you must combine them into a Virtual Data Set because 
reprocessing is restricted to data within a single data set. To create a Virtual Data set, first 
highlight the desired samples in the Sample table, and then right click on any of the selected 
samples and select Create Virtual Data Set in the pop-up menu.

Figure 35. Selecting multiple samples using “Control+Click” to select non-adjacent samples

NOTE When more than one sample is displayed in an overlay electropherogram plot hovering the 
mouse over one of the plots will highlight the plot itself and the corresponding row in the 
Samples table. Conversely, hovering the mouse over a row in the Samples table will highlight 
sample in the table and the corresponding plot in the electropherogram.

Figure 36. Create a Data set
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A dialog opens to name the Virtual Data set.

Select the desired project, enter the desired names, and if desired select a calibration ladder. Click 
on the Create button and the new Virtual Data Set will appear in the Data Files tree. Click on this 
data set, and only the samples included in the Virtual Data Set will be in the Samples table and only 
the first sample will be selected and displayed. Before proceeding use “Shift+Click” or 
“Control+Click” to select the other samples in the Virtual Data Set.

To reprocess the data selected in the Samples table, select the desired Processing Method and 
click Process.
 

Figure 37. Virtual data set name

Figure 38. Virtual data set display

Figure 39. Data Processing
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The new processing method will be displayed in the Processing Method column in the Samples 
table which is immediately to the right of the Sample Name. 

9 After review, data can be exported in QDF, PDF, CDF or CSV formats.

Export and Reporting
 

• All Export and Reporting functions will include only the data currently selected in the Samples 
table and viewed on the Electropherogram at the time that any of the buttons shown in 
Figure 40 are clicked.

• Selecting QDF export will create a file readable by Gly-Q Manager. This is particularly useful for 
sharing data with fellow researchers. 

• Selecting PDF export will create an electronic report that can be printed. The report will include 
electropherograms and peak data tables for selected samples. The logo at the top of the 
report and the footer comment can both be customized in the File->Account tab.

Figure 40. Exporting and Reporting icons
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• Selecting CDF export will create a set of files in the industry standard AIA format that can be 
viewed by other analytical data packages such as Chromeleon and Empower.

• Selecting Excel export includes four options. Clicking on the button selects the first option. To 
select any of the other options you must click on the small black arrow within the button to 
pop up the selection list shown in Figure 42.

Figure 41. Gly-Q report

Figure 42. Excel export options
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XLSX Report

This report is a native Excel File with multiple worksheets.

Summary - A list of the data included in the report with tabular data for all samples.

Graphs - An overlay chart as seen on the screen when the report is created. This is a native Excel 
chart and can be adjusted within Excel. It also includes X and Y offset controls to stack and/or fan 
the traces.

Figure 43. XLSX report

Figure 44. Graph report
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Numbered worksheets - There will be one worksheet for every sample in the report and it includes 
a chart and peak table.

Results - A worksheet identical to the CSV (processed peaks) report described below. PLEASE DO 
NOT EDIT THIS WORKSHEET.

XY - A worksheet identical to the CSV(XY) report described below. PLEASE DO NOT EDIT THIS 
WORKSHEET.

Graph Calculations - Calculations made to configure the other worksheets in the report. PLEASE 
DO NOT EDIT THIS WORKSHEET.

CSV (processed peaks) Report

This report includes all of the information from the selected samples in a 
comma-separated-values (CSV) format which can be read by Excel and many other programs. 
When opened within Excel the pivot table function can be used to perform custom data analysis. 
This report includes only the peaks for each sample that are within the processed data range, see 
“Integration parameters” on page 40.

CSV (raw peaks) Report

This report is identical to the previous report except that it includes all peaks in the samples. This 
makes the report much larger and should be selected only when the peaks outside of the 
processed data range are of interest.

Figure 45. Numbered worksheet report
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CSV (XY) Report

This report includes the electropherogram trace data for all of the selected samples in the same 
CSV format. This raw data can be used to create custom graphs in Excel and many other 
programs.

Data Management: Archive and Delete

Over time the number of projects increases hence it becomes more difficult to find the data you 
are looking for. To simplify searching for data in the database you can archive and delete projects.

The data files tree is shown in three pictures in Figure 46. On the left the selected project is under 
Projects which is the active database. In the center the selected project is under Archive which is 
used to hold valuable projects that will not be accessed frequently outside of the active database. 
On the right the selected project is under Trash which is used to place projects which are no 
longer needed.

The three buttons used for data management are shown in Figure 46.

• The Archive button is used to move projects from the active database into the archive.

• The Restore button is used to move projects from either the archive or the trash into the active 
database.

• When the selected project(s) is in the active database or the archive the Delete button moves 
them to the trash.

• When the selected project(s) is in the trash the Delete button will remove the project entirely.

Creating a processing method
Processing method defines peak alignment, peak integration and peak calling. Gly-Q Manager 
installs equipped with several examples of processing methods.

• Enbrel_Method: contains GU values for InstantQ-labeled N-glycans from Enbrel (Fc fusion 
protein) produced in CHO. Mainly biantennary glycans, some with α(2,3)-linked sialic acid, with 
some Man5.

• Global_Method: GU values for a broad range of N-glycans, combining the data from all 
processing methods listed.

Figure 46. Data management options

NOTE The functions of these buttons can also be accessed by using right-clicking on the selected 
project(s).
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• hIgG_Method: N-glycans from human IgG, biantennary, some with α(2,6)-linked sialic acid, 
some with bisecting GlcNAc. For glycoproteins produced in CHO use the Enbrel or Rituxan 
processing methods. Glycoproteins made in CHO generally lack bisecting GlcNAc N-glycans, 
sialic acid is α(2,3)-linked in CHO versus α(2,6)-linked in human IgG, and human IgG does not 
contain a significant amount of high mannose type glycans.

• Rituxan_Method: N-glycans from Rituxan, monoclonal IgG made CHO. Biantennary, some 
high mannose.

• RNaseB_Method: high mannose type N-glycans, Man5 through Man9.

While these methods can be used as a starting point, each laboratory is expected to develop and 
validate a processing method that meets the needs of a specific application. 

To create or modify a processing method:

1 Select the Processing Method tab, and pick one of the existing processing methods from the 
drop-down menu.

2 In the Representative Sample tab, select a sample that most closely matches the samples 
you plan to process. 

Figure 47. Processing Method tab

Figure 48. Representative sample selection

NOTE To use a ladder injection to analyze data from other runs ladder injections can be 'added to the 
global ladder pool' by right-clicking on a ladder injection, see “Alignment parameters” on 
page 41.





Agilent Gly-Q Glycan Analysis System User Manual 39

3 Open the peak table by clicking on + sign and review peak integration.

4 Review peak detection and integration by highlighting peak line in the peak table and reviewing 
peak start and end markers on Electropherogram view. If needed, zoom in by clicking and 
dragging a rectangle around the area of interest; zoom out with a right mouse click and select 
un-zoom. 

Figure 49. Samples table

Figure 50. Electropherogram
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Integration parameters

In the Integration Parameters Tab there are four parameters available.

• Select the Baseline Valley-to-Valley Modulation level. A setting of 100% is recommended, 0% 
is a flat baseline, and 50% is half way between these settings.

• Select the Shoulder Detection level. The 'Default' setting detects peak shoulders as separate 
peaks and is recommended. The 'none' setting turns off shoulder detection and identifies peak 
with shoulders as a single peak. The 'aggressive' setting changes the parameters defining 
peak shoulders and detects more shoulder peaks but is rarely needed.

• Adjust the Minimum Percent/Area using the slider or by entering a number directly until all 
peaks of interest on the representative sample electropherogram are displayed.

• Select the Processed Data Range by entering left and right window values. Settings of 4 and 
14 are recommended. Only peaks within the processed data range are included in sample 
analysis. Although not recommended, if the processed data range is increased and includes 
the LMS and/or the UMS, these Migration Standards will be omitted from the percent area 
calculations.

In the Component Table tab, check the Glycan Naming checkbox, define Peak Names, GU Units, 
and Left and Right windows. The empty row at the bottom of the table can be used to add 
Glycans to the table.

Figure 51. Integration parameters

Figure 52. Component table

NOTE The Left Window and Right Window value controls will simultaneously change all values in the 
table that are currently set to the value displayed in the controls. Values in the table that are 
not the same as the values in the controls will not be changed.
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Alignment parameters

In the Alignment tab parameters are set in three sections. 

• Migration Standards: Define the Lower and Upper Migration standards which are normally 3 
and 15 respectively. The 'Standard' LMS Search Method and checking Predictive UMS Search 
are both recommended however the 'allow relatively small peaks' setting for the LMS Search 
Method and/or unchecking the Predictive UMS Search may be useful if the migration standard 
peaks are small relative to the sample peaks.

• Optional Alignment Controls: This parameter was introduced in version 1.3, and should be 
used with caution. When samples are known to include a specific glycan that is included in the 
Component Table this setting can be used to identify the glycan and alignment will be 
adjusted using the known GU value of this glycan.  The Peak Name drop down is used to 
identify the specific glycan and the 'Tallest' Search Mode setting is recommended. This should 
only be used when the glycan is present in all samples being analyzed, there are no other 
peaks near the specified glycan that could cause miss-identification of the correct peak, and 
the GU value for the glycan in the Component Table is correct. If any of these things are not 
true then analysis of all peaks will be adversely affected.

• Dextran Ladder Rule: All runs should start with a Calibration Ladder injection which will be the 
latest (most recent) ladder and this option is recommended. If there is a problem with the 
ladder injection within a specific run then the software includes ladder data that will be used. 
The Use Specific Ladder setting allows you to use a ladder injection from a different 
experiment. This is rarely necessary and to use a ladder it must be included in the Global 
Ladder Pool, see Representative Sample tab on page 38. The drop down selection allows any 
ladder in this pool to be specified. 

5 Save the Processing method by clicking on Save or Save As.

Figure 53. Dextran ladder rule

Figure 54. Save options

NOTE After a processing method has been applied to a data set we recommend using 'Save As' if 
you wish to make changes to the method.
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Creating an instrument method
Instrument method defines a set of instrument commands needed to execute the sequence. 
Gly-Q Manager ships with several examples of instrument methods that can be modified and 
saved by the user. 

To create or modify an instrument method:

1 Select the Instrument Method tab and pick one of the existing instrument methods from the 
drop-down menu.

2 Modify instrument commands for Calibration Ladder, Unknown Sample, and End of Sequence 
steps by selecting Action, High Voltage, Duration, and Autosampler Position. 

 

Figure 55. Instrument Method tab

Figure 56. Calibration Ladder

Figure 57. Samples

Figure 58. End of Sequence
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The following instrument commands can be used to create an instrument method. Click on the 
box in the Action column in any row three times to bring up the pop-up menu in Figure 59 to select 
a command.

• High Voltage Purge: both high voltage and air pressure driven capillary purge

• Purge: air pressure only driven capillary purge

• Pause: pausing between steps

• Reagent Block Injection: injection from dedicated reagent wells and troughs on the 
autosampler

• Well Plate Injection: injection from a 96-well plate

• Separation and Detection: running the sample and collecting data

By default, Detector Sensitivity is set to High for standard instrument methods. Sensitivity can be 
turned down to either Medium of Low if saturated peaks are observed within the Processed Data 
Range, see “Integration parameters” on page 40.

3 Save the Instrument method by clicking on Save or Save As.

Figure 59. Action menu

Figure 60. Detector Sensitivity setting

Figure 61. Save options

NOTE Instrument Methods that have already been used in a sequence cannot be overwritten and can 
only be saved under a different name (Save As option). 
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Ending a run
1 After samples have been processed, the system will return the Cartridge to the Park position 

(see “Autosampler layout” on page 25).

2 Use the “Load Sample” and “Load Reagents” buttons to remove sample plate and reagent tray.

3 Store the cartridge.

a Remove the cartridge form the instrument and place tape over the cartridge cap (to cover 
the pin hole). Return it to the original clamshell packaging. The cartridge tip must be in 
contact with the gel block inside the package. Place inside the foil pouch and store 
vertically at room temperature.

b To store on the instrument: Press the Park button before shutting down the system. The 
cartridge can remain on the system for up to three days. Fill the Park position of the 
buffer tray (“Autosampler layout” on page 25) with water to prevent the cartridge tip from 
drying during storage on the instrument.

4 Samples may be stored, covered with sealing film, at -20 °C for at least on month or up to five 
days at 4 °C.

File settings
File settings capture instrument serial number, cartridge and reagents lot information, define 
custom fields on data reports, perform Air and Gel flow checks. 

To update system settings, select the File tab.

Figure 62. File tab
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Cartridge and reagents settings

Instrument and software settings
Insrument 

Account settings

Figure 63. Cartridge and Reagents settings

Figure 64. Instrument and Software settings

Figure 65. Account settings

NOTE The Logo and Comment fields will appear in exported PDF reports.
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Data storage settings

Air flow check

Gel flow check

Figure 66. Data storage settings

NOTE This setting is for information only and cannot be changed.

Figure 67. Air flow check

Figure 68. Gel flow check
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Care and Maintenance 
Time Interval Procedure

Cleaning Please clean the instrument with dry cloth

During Operation Check the pressure on the software status bar to ensure that it is between 45 and 60 psi.

Weekly Check the condensation trap on the gel recharging air pump for condensation. If there is 
condensation in the trap it should be drained 

• Turn off the power to the air pump.
• Loosen the nut on the bottom of the condensation trap to drain the water from the trap.
• When the trap is empty, tighten the nut to seal the condensation trap.
• Turn on the power to the air pump; it will run briefly to pressurize the system and then turn off..

Monthly In addition to emptying the condensation trap as described above, check the air filter: 
• Turn off the power to the air pump.
• Loosen the nut on the bottom of the condensation trap to drain the water from the trap.
• When the trap is empty, tighten the nut to seal the condensation trap.
• Check the air filter. If the filter is damaged or wet, use a new filter to replace the old one. 

Replacement air filters are supplied with the instrument and are available from Agilent.
• Turn on the power to the air pump; it will run briefly to pressurize the system and then turn off.
• Check the air flow using the Air Flow Check functionality described in “Ending a run” on 

page 21.





48 Agilent Gly-Q Glycan Analysis System User Manual

System Specifications
General technical specifications

Instrument specifications

Gel recharging air pump specifications

Environmental conditions
Operating temperature 
Operating humidity 
Operating altitude


20 to 30 °C 
40 to 95% RH, noncondensing 
20 to 2,000 m

Conditions of transportation and storage
Temperature 
Humidity


-30 to +60 °C 
20 to 80% RH, noncondensing

UL installation category Category II

Input voltage 24 V DC 1.25 A Maximum

Output voltage 1 to 10 kV 

Light source LED (310 nm)

Fluorescence detector Photomultiplier tube, A/D resolution 18-bit, long pass filter >385 nm 

Computer connection USB 2.0 or greater

Physical dimensions (L x W x H) 38 cm (L) x 30 cm (W) x 40 cm (H) 

Weight 15 kg 

Inlet air pressure 50 to 75 psi

Power supply SINPRO MPU32B-108

Power supply input voltage 100 to 240 V AC, 47-63 Hz 
Suggestion: Use a surge protector outlet for the instrument and the computer to avoid 
electromagnetic interferences and damages to the inner electrical devices.

Input voltages 12 V DC 6.67 A Maximum

Output pressure range 50 to 60 PSI

Dimensions 16.5 cm(L) * 12.5 cm(W) * 10.5 cm(H)

Weight 1.4 Kgs

Power supply MEAN WELL GSM90B12-P1M

Power supply input voltage 100 to 240 V AC, 47-63 Hz 
Suggestion: Use a surge protector outlet for the instrument and the computer to avoid 
electromagnetic interferences and damages to the inner electrical devices.
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Warranty Statement
Limitation of Liability

Gly-Q Analyzer, software, and all related reagents are designed for the use of electrophoresis 
analysis in general bio-chemistry laboratory for Research Use Only. 

BEFORE ATTEMPTING TO OPERATE THE INSTRUMENT, READ ALL PRODUCT MANUALS AND 
FOLLOW THE INSTRUCTIONS.

Agilent assumes no liability whatsoever for any personal injury, property damage, or other loss 
resulting from not complying or familiar with the manuals, or improper operation of the devices.

Warranty statement

Agilent warrants all purchased products (other than extended warranties) against damage, 
defects in materials or workmanship, and failure to conform to the Quality Specifications, for the 
period commencing upon receipt of each purchased product by Agilent Technologies, Inc. 
through one year after delivery of such purchased product to Agilent’s customers.

If, during the warranty period, any purchased product is discovered to be defective by reason of 
materials, workmanship or failure to meet the Quality Specifications, please contact Agilent 
Technical Support at https://www.agilent.com/en/contact-us/page.

Terms and conditions of sale may be found at: www.agilent.com

https://www.agilent.com
https://www.agilent.com/en/contact-us/page
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Instructions for Depot Repair Returns
To return the instrument for repairs, follow the steps below to clean surface and detached 
connectors and tubing.

1 Open the cartridge door and ensure there is no cartridge in the instrument.

2 Check the sample and buffer tray to ensure there is no sample or fluid left in the instrument.

3 Turn off the power to the instrument and turn off the power to the gel recharging air pump.

4 To cut off the power disconnect the power plug to the instrument and the power plug to the 
gel recharging air pump.

5 Unplug the USB cable in the back.

6 Unplug the power cable in the back.

7 Secure the cable node. Pull the connector header to unlock and detach the cable from 
instrument.
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8 Remove the air tubing by simultaneously pressing the connector and remove the tubing 
rapidly.

9 Clean the outside of the instrument with dry cloth. 

10 Print and fill out the Decontamination Certificate, Figure 69 on page 52. Pack the form with the 
instrument and contact Agilent or your local distributor for shipping details. The User Manual 
is available at http://agilent.com/products/gq2100.
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Figure 69. Decontamination certificate
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FAQs
Q. Why does Gly-Q Manager not allow me to edit the Sequence Table I am preparing?

A. Be sure you have entered a Run Name before editing the Sequence Table.

Q. Does the Gly-Q instrument require a minimum volume for analysis?

A. The Gly-Q instrument requires a volume of at least 30 µL in a 96 well plate well for a run. 

Q. Gly-Q Manager does not seem to be communicating to the instrument. How can this be 
fixed?

A.  Ensure that the USB cable is intact and installed correctly.

Ensure that the instrument is turned on. 

If 1 and 2 above are confirmed, reboot the instrument and computer. Occasionally 
communication can be lost if a prolonged period of inactivity is incurred. 

Gly-Q Manager installs a Device Driver. If the driver is not installed properly instrument 
communication will not occur. Check with your IT professional to insure your computer is 
configured to accept Device Driver installation. 

Q. What should I do about injection count warning or error messages?

A. The Gly-Q cartridges have both an expiration date and a limit on the number of injections that 
can be done using each cartridge. When the cartridge is old or has been used for many injections 
the performance may deteriorate. Cartridges have an absolute limit of 250 injections and a 
recommended limit of 200 injections.

In this case the run can be started but there it is possible that the cartridge performance will 
degrade during the run. This is unlikely and in most cases the run will be completed successfully.

In this case the run cannot be started until you reduce the number of injections in the sequence.

Figure 70. Warning Message - Exceeding the Recommended Injection Limit of 200

Figure 71. Error Message - Exceeding the Absolute Injection Limit of 250
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In this case you must use a different cartridge to perform the run.

Q. How do I resolve the “Cannot Get Cartridge Information” error message?

A. This message indicates that there is a problem reading the information on the cartridge RFID 
tag. In most cases the system will allow you to enter the cartridge information manually (see 
“Starting and Stopping a sequence” on page 26) but in this case manual entry is no longer 
working. If this happens you must contact Agilent technical support for assistance.

Q. How do I resolve the “Low Pressure” error message?

A. Ensure that pump is turned on. If the pump is on then check that the airline connections are 
intact and that the air filter is current and functional. The Airline Check in “Ending a run” on 
page 21 is another way to check this parameter.

Q. The Air Pump runs quite frequently. Is this normal?

A. The air pump should run for ~ 30 seconds sporadically throughout an analysis session. If the 
pump is running for greater than one minute regularly throughout the run this could be an 
indication of air flow compromise. Again, the user should check integrity of airlines, air filters and 
perform the Air Flow function described in “Ending a run” on page 21.

Figure 72. Error Message - Cartridge has Expired

Figure 73. Error message - Cannot Get Cartridge Information

NOTE If this happens you will be able to use the system with any cartridge that has a working RFID 
tag.

Figure 74. Error message - Low Pressure
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Q. When is the Gel Flow Check function used?

A. The Gel Flow Check in “File settings” on page 44 is used to insure gel flow in a cartridge is 
optimal. If a cartridge is stored improperly the capillary may become clogged and consequently 
functionality may also be affected. The Gel Flow Check can be used to determine presence of a 
potential clog. If a blockage is detected the user is advised to prime the cartridge as described in 
the cartridge preparation “Priming the cartridge” on page 19. If priming does not resolve this, 
proceed to the next FAQ.

Q. Peaks are migrating later than usual and have poor shape. How do I resolve this?

A. Check the Current trace by clicking the Current box on the data ribbon (see “Data review, 
export, reporting, and management” on page 27). If the current is low or erratic, it may indicate a 
blocked cartridge. 

It is recommended that the Gel Flow Check function under the 'File' menu in Gly-Q Manager be 
used whenever a cartridge is inserted into the Gly-Q System before performing a run (“File 
settings” on page 44). Since the capillary has a small inner diameter (0.75 µm) the tip of the 
capillary can become clogged and the Gel Flow Check may fail (no gel droplet observed). When 
this occurs the brief procedure below will often unblock the cartridge tip and restore normal 
operation.

1 Remove the cartridge from the system and follow the procedure in “Priming the cartridge” on 
page 19.

2 If droplets of gel are visible in step 7 of the Priming procedure, the cartridge has been 
unblocked by Priming as gel is flowing, and the cartridge can be returned to the Gly-Q system. 
There is no need to repeat the Gel Flow Check when the cartridge in inserted into the system. If 
the gel does not flow, continue to step 3.

3 The next step is to perform a priming procedure with the capillary tip submerged in hot water 
(80 °C). This should be done with deionized or distilled water.

4 Fill the buffer tray in the purge stand with the hot water and then turn the black 'Switch Knob' 
at the top of the purge stand to lower the cartridge until the capillary tip is submerged in the 
hot water.

5 Adjust the 'Regulator Knob' to increase the pressure until it reaches approximately 0.4 mPa.

6 Leave the capillary tip submerged in the hot water under pressure for 10 minutes.

7 Turn the black 'Switch Knob' to raise the cartridge until the capillary tip is no longer 
submerged. Leave the pressure at ~0.4 mPa.

8 Wait for 120 seconds (two minutes) and examine the capillary tip. If gel is visible, the cartridge 
is no longer clogged and can be returned to the Gly-Q system. There is no need to repeat the 
Gel Flow Check when the cartridge is inserted into the system. If the gel does not flow then 
prepare another aliquot of hot water and repeat steps 4 through 8 a second time. Do not use 
the same aliquot of hot water as it will no longer be hot after being in the buffer tray for more 
than 10 minutes. If the cartridge is still clogged after the second purge in hot water then the 
cartridge cannot be unblocked and you must use a different cartridge.

NOTE If the air line is already connected to the purge stand there is no need to turn off the air pump.

NOTE If a thermometer is not available the water can be boiled and then allowed to stand for about 
five minutes before continuing. The temperature does not need to be exact but boiling water 
should not be used immediately.
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Q. The Lower Migration Standard (LMS) and/or Upper Migration Standard (UMS) were not 
found or aligned correctly. What can I do?

A. The LMS and UMS can be identified manually when needed. Select the data on the Data Tab 
and set the Data View to Raw so all peaks in the sample will be included. In the Samples table, 
expand the sample to list all peaks as shown in the illustration below. Right click on the sequence 
that corresponds to the LMS/UMS and designate it as such. Gly-Q Manager further helps facilitate 
this process by enabling visualization with the corresponding electropherogram in the window 
above the Sample. Please see Figure 75 for an example. 

 

Manually designated LMS or UMS will be named accordingly in bold print, see Figure 76:

 

Figure 75.

Figure 76.
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Q. When collecting data, why can it not be saved in real time on a network or to a cloud 
location?

A. The system collects data in real time and is designed to save data on the local hard drive to 
prevent data loss if the network or internet connections are down. Once data has been collected 
there are a number or options available to move data to other computers. You can move data to a 
different computer running Gly-Q Manager using the data export and data import functions using 
the QDF data file format. If you want to analyze data using programs that support the industry 
standard AIA format such as Chromeleon or Empower you can use the data export function with 
the CDF data file format. If you want to analyze data using Excel you can export to a native Excel 
file or to CSV (comma-separated-values) files (use the arrow on the Excel Export button to select 
CSV file options). CSV files are also supported by a variety of other programs.

Figure 77.
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Legal Notices
Virtual patent marking

Visit www.agilent.com for a list of Agilent products and patents.

https://www.agilent.com
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Resources and References
Visit the Agilent website for additional information, downloadable posters, publications, and 
technical notes: 

www.agilent.com

https://www.agilent.com
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Technical Assistance
Agilent is committed to developing rapid, automatable methods for glycan analysis. Call us to 
discuss products in development.

If you have any questions or experience difficulties regarding any aspect of our products, please 
contact us:

https://www.agilent.com/en/contact-us/page

Agilent values customer opinions and considers customers an important source for information 
regarding advanced or specialized uses of our products. We encourage you to contact us. We 
welcome your suggestions about product performance or new applications and techniques.

https://www.agilent.com/en/contact-us/page
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